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Foreword

This software is designed for presentations and for enhancement of
images projected from SHARP LCD projectors. It includes the following
functions:

Projector Control Software:
RS-232C Control
This function allows you to control the projector’s functions/adjustments
from your PC.
The projector can be controlled from a central PC/CONTROLLER.

Image Enhancement Software:
Gamma Correction
This function allows you to set the projector’s Gamma values directly
from your PC. The ease of specifying preset values enables very precise
custom brightness, contrast and colour adjustments.

Support Software for Presentation Transfer:
Presentation Transfer
This mode transmits BMP and JPEG images to a projector. By saving
presentation slides as BMP or JPEG images you can do an entire
presentation with SHARP LCD projectors.

Capture & Transfer
This mode allows you to transmit an image of what is currently displayed
on your monitor. This is as simple as pressing the “Capture & Transfer”
button in the application.

Quick Transfer
This mode is similar to “Capture & Transfer” but it can be used easily by
clicking the “Right” mouse button, even during a Microsoft PowerPoint
presentation.
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This software operates under the Microsoft Windows 95 and 98 operating
systems. This manual references only these Microsoft Windows
Operating Systems and compatible Mouse devices. For details please
refer to the Microsoft Windows operation manual.

Note that Sharp Advanced Presentation Software is subject to change
without prior notice for upgrading and improvement.
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If you want to project your presentation slides saved as BMP or JPEG
files...

Presentation Transfer transfers images quickly &
easily in presentation format. (See page 35)

If you want to project an image of what is currently displayed on your monitor...

Capture & Transfer captures the image on the PC
monitor and transfers it to the projector. (See page 39)

If you want to project a single image quickly...

For Your Reference

There are five functions via RS-232C serial port.

Quick Transfer captures the image on the PC monitor
and transfers it to the projector using the mouse as a
shortcut. (See page 40)

If you want to control the projector adjustments from your PC...

RS-232C Control controls the projector adjustments
via the RS-232C serial port. (See page 16)

If you want to adjust image colours on the screen...

Gamma Correction controls the image colours via the
RS-232C serial port. (See page 28)
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� Microsoft and Windows are registered trademarks of Microsoft Corporation, USA.
� All other brand or product names are trademarks or registered trademarks of

their respective holders.
� Great effort has been expended to ensure that the descriptions in this manual

are correct. Should you, however, come across an inconsistency, a telephone
call or letter to SHARP Corporation noting the questionable area would be highly
appreciated.

� This software is the property of SHARP Corporation and all related copyright and
other rights belong to SHARP Corporation.

� This manual may not be transferred wholly or in part in any form whatsoever
without prior written permission. Uses other than personal use are for copyright
reasons not permitted without the written permission of SHARP Corporation.

� SHARP Corporation shall in no event be liable for damages, loss of revenue or
third party claims arising from the use of the software.

� Software specifications and the contents of the operation manual are subject to
change without prior notice.

� Operating speed may slow down depending on computer operating environment
and processing capability.

� The software is based on modules developed by the Independent JPEG Group.
� The software uses LEAD Tools Pro developed by Bunka Orient Corp. and Lead

Technologies, Inc.
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Required Hardware and Software

Sharp Advanced Presentation Software requires the following
hardware and software for operation.

PC running under Microsoft Windows 95 or Windows 98
CPU 233 MHz Pentium or higher is recommended.

Display A 800 × 600 dot display capable of displaying
65,536 colours or more

Memory 32 MB or more

Hard disk free space 50 MB or more

Interface An available RS-232C D-Sub 9 pin serial port for
transferring images and controlling the projector
RS-232C cable (cross type) is required for
connecting projector with PC.

CD-ROM drive

We cannot guarantee that the software will operate on computers whose
motherboards have been changed or modified, or on computers that
the users have configured themselves.

Projector and PC Connections

This software requires the use of RS-232C serial cable. For details on
PC connections, refer to the projector’s operation manual.

CAUTION
Before connecting, be sure to turn both the projector and the computer
off. After making all connections, turn the projector on first. The computer
should always be turned on last.

Please read the computer’s instruction manual carefully.

RS-232C connection

Optional RS-232C cable
(cross type)

Refer to the
projector’s operation
manual for details.
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Installing the Software

This software can be installed using the installation programme supplied
on the “Sharp Advanced Presentation Software CD-ROM”.

1 Insert the “Sharp Advanced Presentation Software
CD-ROM” in the CD-ROM drive.

2 Double click the “My Computer” icon.

3 Double click the CD-ROM drive icon.

4 Double click the “saps2_2” folder.

5 Double click the “Setup.exe” icon.
w The “Sharp Advanced Presentation Software Opening Image”

will be displayed.

w The “Sharp Advanced Presentation Software” dialogue box
will open.
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6 Click “Next>”.
w The “Choose Destination Location” dialogue box will open.

7 The folder under which the software will be installed is
displayed in “Destination Folder”.

To select another folder, click “Browse...”.

8 Click “Next>”.
w “Auto-Launch Setup” dialogue box will open.
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9 Click “ON” under “Auto-Launch” to automatically launch
the software every time you start your PC. (Recommended)

If you set “Auto-Launch ON”, a “Sharp Advanced Presentation
Software” icon will reside in the Windows task tray. If not, use
the “Sharp Advanced Presentation Software” shortcut icon on
the desktop or the Windows “Start” menu.

10 Click “Install>”.
w Installation will start.

w When the installation is completed, the “Setup Complete”
dialogue box will open. To use the programme immediately,
please restart your computer.

11 Click “Finish”.
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Uninstalling the Software

Always uninstall Sharp Advanced Presentation Software, when
installing a new or updated version.

Before Uninstallation
� Software uninstallation can not be done when Sharp Advanced

Presentation Software is running.
Please make sure that the software is closed before proceeding.

� Before uninstalling Sharp Advanced Presentation Software, the
“Auto-Launch” setting must be “OFF”.
1) Double click the “Sharp Advanced Presentation Software” icon.
2) Click the “Option” menu, select “Auto-Launch ON/OFF”.
3) Select “OFF”.
4) Close Sharp Advanced Presentation Software.

1 Click “Start”, and then click “Settings”, then select
“Control Panel”.

2 Double click the “Add/Remove Programs” icon.

3 Click the “Sharp Advanced Presentation Software”.



11

In
stallin

g
/

U
n

in
stallin

g

4 Click the “Add/Remove...”.

5 Click the “Yes”.

6 When uninstallation is correctly completed, “Uninstall
successfully completed” message will appear. Click “OK”.
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Starting and Quitting

Opening Modes

Before starting the software, make sure that the projector and the PC
are correctly setup (page 6). There are three ways to start up the software.

Starting from the “Sharp Advanced Presentation Software”
icon in the Windows task tray

This icon appears when “Auto-Launch ON” is selected. See page 14
for “Auto-Launch” setting.

1 Start up the projector.
Make sure to turn the projector on first. The computer should always
be turned on last.

2 Start up the PC. Click the “Sharp Advanced Presentation
Software” icon in the Windows task tray.
w The “Sharp Advanced Presentation Software” window will

open.

3 Select the mode you require from the “Mode” menu. Or
you can use the shortcut buttons below the menu bar.

Gamma
Correction

RS-232C
Control

Presentation
Transfer

Capture &
Transfer

w The mode dialogue box will open.
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Starting from the Windows “Start” button

1 Start up the projector.
Make sure to turn the projector on first. The computer should always
be turned on last.

2 Start up the PC. Click the “Start” button, set the pointer
to “Programs” and then “Sharp Advanced Presentation
Software”, and then select the mode you require.
w The mode dialogue box will open.

Starting from the “Sharp Advanced Presentation Software”
shortcut icon on the Windows desktop

1 Start up the projector.
Make sure to turn the projector on first. The computer should always
be turn on last.

2 Double click the “Sharp Advanced Presentation Software”
shortcut icon on the Windows desktop, and then select
the mode you require.
w The mode dialogue box will open.



14

Changing Auto-Launch Setting

The default “Auto-Launch” setting is “ON”, which launches this
software automatically when the PC starts up. You can change the setting
as follows.

1 Click the “Option” menu, select “Auto-Launch ON/OFF”.

2 Select the setting as required.

When “Auto-Launch ON” is selected
� The “Sharp Advanced Presentation Software” icon is resident in

the Windows task tray.
� The software is automatically launched when the PC starts up.

When “Auto-Launch OFF” is selected
� The “Sharp Advanced Presentation Software” icon is removed

from the Windows task tray.
� In this case the software must be started from the “Start” menu or

the “Sharp Advanced Presentation Software” shortcut icon on the
Windows desktop.

Quitting

Click the “File” menu, and select “Exit”.
Or you can use the  button.
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Help

To view Help, click the “Help” menu. When the “Help” window opens,
click the desired item in the Help list.

To check the software version, select “About This Software...” from
the “Help” menu.
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Controlling the Projector’s Adjustment

RS-232C Control

This function enables you to control the following projector adjustments
from your PC.
Refer to the projector’s operation manual for details on each adjustment.

Adjustment Sheet Page

Auto Sync

Black Screen

Digital Shift

Focus

Freeze

Input Select

Keystone

Power

PRJ Mode

Input1/2 Gamma

Input3 Gamma

Zoom

Input1 PICT/Input2 PICT

Input1 Resize/Input2 Resize

Input1 Signal Type/Input2 Signal Type

Input1 I/P Conversion/Input2 I/P Conversion

Auto Sync Display

Auto Sync Setup

Input Adjust

Settings

Special Modes

Input3 I/P Conversion

Input3 PICT

Input3 Resize

Audio Adjust

Mute

Volume

Auto Power Off

Background Image

Black Screen Display

OSD Display

Startup Image

Video System

Set Up

Input1 PICT/Input2 PICT

Fine Sync

Input3 PICT

Audio

Options
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� Adjustments can still be made from the RS-232C Control utility
regardless of the difference in settings in the projector’s menu.

� If you move to RS-232C Control during Presentation Transfer,
Capture & Transfer or Gamma Correction, Sharp Advanced
Presentation Software automatically confirms the adjustments on
the projector and shows them in the “RS-232C Control” window as
default settings.

� Also when you change the sheet of the “RS-232C Control” window
to proceed to the other projector adjustment, this confirmation is
performed. In this case, it will repeat at regular intervals afterwards
and the “RS-232C Control” window may show the settings on the
projector.

� The Automatic Power Shutoff function will not operate when
performing RS-232C Control, although you turn “Auto Power Off”
ON in the “Options” sheet. This function operates during
Presentation Transfer, Capture & Transfer, or Gamma Correction.

� To use RS-232C Control after transferring images in “Presentation
Transfer”,“Capture &  Transfer” or “Quick Transfer”, switch the
input in “Input Select” (page 18).

Before Adjusting
Please connect a serial (RS-232C) cable to the projector and the PC
(page 6), select the correct COM Port on the PC, then proceed with
RS-232C Control.

1 Select the “RS-232C Control” mode.
See section “Opening Modes” (page 12).
w The “RS-232C Control” window will open.

2 Click the tab of the sheet including your desired
adjustment controller.
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“Set Up” Adjustment

1 Select the “Power” ON/OFF.
2 Select the “Input Select”.
3 To make “PRJ Mode” select
4 To make “Input1/2 Gamma” select
5 To make “Input3 Gamma” select
6 To make “Focus” adjustments
7 To make “Keystone” adjustments

Slide the bar to the desired location or simply type in the desired
value in the box.

8 To make “Digital Shift” adjustments
9 To make “Zoom” adjustments
0 Select the “Black Screen” ON/OFF.
q To start “Auto Sync”

Press the “Auto Sync” button.
w Select the “Freeze” ON/OFF.
e To send all the adjustment data to the projector

Press the “Send” button to control all the adjustments on this
sheet.

r To receive data from the projector
Press the “Receive” button to confirm the adjustments on the
projector.

t A “NOW TRANSMITTING...” message is displayed during
transmission.

When using the PG-C30X, since operation is manual, the
“Focus” and “Zoom” adjustments cannot be performed.

1

2

3

4

5

0 q w e r

6

7

8

9

t
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“Input1 PICT”/“Input2 PICT”/“Input3 PICT” Adjustment

� For “Input1 PICT” adjustment, “Color”, “Tint” and “Sharp”
adjustments are available for component input signal only. (“Sharp”
adjusts DVD 480i signal only.)

� For “Input2 PICT” adjustment, “Color”, “Tint” and “Sharp”
adjustments are not available.

1 to 8: Slide the bar to the desired location or simply type in the desired
value in the box.

1 To make “Contrast” adjustment
2 To make “Bright” adjustment
3 To make “Red” adjustment
4 To make “Blue” adjustment
5 To make “Color Temp” adjustment
6 To make “Color” adjustment
7 To make “Tint” adjustment
8 To make “Sharp” adjustment

9 To reset the adjustments 1 to 8
Press the “Reset” button.

0 To make “Signal Type” select
q To make “Resize” select

Select a size mode from the pull down menu. It will change the
pixel composition to resize the picture on the screen.

w To make “I/P Conversion” select

e To send all the adjustment data to the projector
Press the “Send” button to control all the adjustments on this sheet.

r To receive data from the projector
Press the “Receive” button to confirm the adjustments on the projector.

t A “NOW TRANSMITTING...” message is displayed during
transmission.

When using the PG-C30X, the “Sharp” adjustment cannot be performed.

1
2
3
4
5

0

q

w e r

6
7

8

9

t
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“Fine Sync” Adjustment

“Fine Sync” adjustment is not necessary except “Auto Sync Setup”
with Input2 (PanelLink Digital Input) mode.

1 to 4: Slide the bar to the desired location or simply type in the desired
value in the box.

1 To make “Clock” adjustment
2 To make “Phase” adjustment
3 To make “H-POS” adjustment
4 To make “V-POS” adjustment

5 To reset all the adjustments 1 to 4
Press the “Reset” button.

6 Select the “Auto Sync Setup” ON/OFF.
“ON” is for “Auto Sync” whenever the projector is powered or the
input signal is changed .

7 To make “Auto Sync Display” ON/OFF
“OFF” is for displaying Background Image during “Auto Sync”.

8 To store up to seven adjustment settings for use with various PCs.
Connect a PC to the projector and make the adjustments in “Input
Adjust”. And then press one of the “Save No.” buttons to save the
adjustment setting.

� Make a note of the “Save No.” and its stored setting, if necessary.
You cannot check each setting with this software after saving it.

� The previous setting will be overwritten if you save on the same
“Save No.” button.

9 To select the desired adjustment setting for the currently connected PC
Press the desired “Select No.” button.

0 To select the “Special Modes”.
Select “Special Modes” to match the computer display mode when
the correct type of input signal is not detected or when the correct
mode of resolution is not selected automatically.

When inputting DTV 480p signals, select “480p” in “Special Modes”.

1
2
3
4
5

6
7

0

8

9
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“Audio” Adjustment

1, 2, 3 and 5: Slide the bar to the desired location or simply type in
the desired value in the box.

1 To make “Balance” adjustment
2 To make “Treble” adjustment
3 To make “Bass” adjustment

4 To reset the adjustments 1, 2 and 3
Press the “Reset” button.

5 To make “Volume” adjustment

6 Select the “Mute” ON/OFF.
7 To send all the adjustment data to the projector

Press the “Send” button to control all the adjustments on this
sheet.

8 To receive data from the projector
Press the “Receive” button to confirm the adjustments on the
projector.

9 A “NOW TRANSMITTING...” message is displayed during
transmission.

When using the PG-C30X, the “Balance” adjustment cannot be
performed.

7 8

5

6

9

1
2
3

4
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“Options” Adjustment

1 to 3: Select ON/OFF.

1 To make “Black Screen Display” ON/OFF
“ON” is for displaying “BLACK SCREEN”.

2 To make “OSD Display” ON/OFF
3 To make “Auto Power Off” (Automatic Power Shutoff) ON/OFF

The Automatic Power Shutoff function will not operate when
performing RS-232C Control, although you set it “ON”.This
function operates during Presentation Transfer, Capture &
Transfer, or Gamma Correction.

4 to 6: Select a mode from the pull down menu.

4 To make “Video System” select
5 To make “Background Image” select
6 To make “Startup Image” select

7 See the next page.
8 To send all the adjustment data to the projector

Press the “Send” button to control all the adjustments on this
sheet.

9 To receive data from the projector
Press the “Receive” button to confirm the adjustments on the
projector.

1

2

3

7

8 9

4

5

6
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7 Press the “Get Information” (Lamp & Signal information) button
to open the “Information” window.

“Model”
Shows the model number of the projector.

“Power Status”
On: The power is on.
Off: The power is off.
Cooling: The power is off with the cooling fan turning. Do not

disconnect the power cord during “Cooling”.
“Lamp Status”

On: The lamp is on.
Off: The lamp is off.
Retry: Retrying to turn on the lamp.
Wait: The lamp is on standby.

“Lamp Timer”
Shows the accumulated lamp usage time. It will be reset when
replacing the lamp.

“Trouble Status”
Temp.: The internal temperature is abnormally high. Something

may block air intake.
Fan: The fan operates abnormally. Check that there is no

obstacle caught in the fan.
Lamp: The lamp has a problem.
Normal: Displayed in the normal operating condition.

“Real Resolution”
Shows the resolution of the projector’s panel.

“Input Status”
Input1/Input2/Input3

“Resolution” (Displayed for Input1/2)
Shows the resolution of the image when projected on the screen.

“Hor Freq” (Displayed for Input1/2)
Shows the horizontal frequency (kHz).

“Vert Freq” (Displayed for Input1/2)
Shows the vertical frequency (Hz).

“Video System” (Displayed for Input3)
Shows the video input system (NTSC or PAL etc.). The “---” will be
displayed when it is a monochrome or there is no signal. For a
forced system, a “*” will lead the system name.
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Save Control Settings and Load Control Settings

You can save all the current RS-232C Control settings of the projector
in your PC (Save Control Settings) and also load the RS-232C Control
values saved in the PC to the projector (Load Control Settings).

To make “Save Control Settings”
Click the “File” menu to select “Save Control Settings”.
All the current RS-232C Control settings of the projector will be saved
in the SAPS folder on the PC.

To make “Load Control Settings”
Click the “File” menu to select “Load Control Settings”.
The RS-232C Control values will be loaded to the connected projector.

� You cannot use this function when “XGNV1-5” is selected in “Select
Projector” dialogue box.

� The projector must be identical for the “Save Control Settings” and
“Load Control Settings”.
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Password setting

Setting the Password

1 Click the “Option” menu to select the “Password”.
The “Set Projector Password” dialogue box will open.

2 Enter 4-digit password using keyboard into the “New
Password” on the “Set Projector Password” dialogue box.

3 Enter 4 digit password using keyboard into the
“Reconfirm” on the “Set Projector Password” dialogue
box.
Check the “Save Password” check box if you want to save the
password.

4 Click “OK” .

After setting the password, be sure to write it down in a secure location
so as not to forget it.
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Changing the Password

1 Click the “Option” menu to select the “Password”.

2 Enter 4-digit old password using keyboard into the “Old
Password” on the “Set Projector Password” dialogue box.

3 Enter 4-digit new password using keyboard into “New
Password” and “Reconfirm” on the”Set Projector
Password” dialogue box.
Check the “Save Password” check box if you want to save the
password.

4 Click “OK” .

The password setting is canceled if “OK” is clicked when nothing is
input into the “New Password” and “Reconfirm” area.
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Selected item Description

Normal

Level A

Level B

All operation buttons are functional.

Only INPUT, VOLUME, MUTE, BLACK SCREEN on
the projector are available.

All operation buttons on the projector are unavailable.

Selecting the Keylock Level

This function can be used to lock the use of certain operation on the
projector.

1 Click the “Option” menu to select the “Keylock Level”.
The “Keylock Level” window will open.

2 Select the keylock level from “Normal”,”Level A” or “Level
B”.
See the diagram below about the description of Keylock Levels.

3 Click “OK” button.
An error message is displayed if the password input at the password
setting differs from the password input to the main unit.

Description of Keylock Levels
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Adjusting Images

Gamma Correction

Changing the gamma value adjusts the tone of an image on the screen.

Before Adjusting
� Use the projector’s Gamma button and set the CUSTOM mode.
� Please connect a RS-232C cable to the projector and the PC (page

6), then proceed to Gamma Correction.

1 Select the “Gamma Correction” mode.
See section “Opening Modes” (page 12).
w The “Gamma Correction” window opens.

1

5
6

7

2

3

4

1 Specify the source of the image. The default setting is
“COMPUTER”

2 The default gamma value is “CUSTOM”, by which you can adjust
the values of the colours in box 3.

The other modes use preset values and you cannot adjust colours
independently in these modes.
“MOVIE”: Emphasizes colour saturation of the entire image.
“FAMILY”: Emphasizes colour saturation of flesh tones.
“SNOW”: Emphasizes white colour in an image.
“NIGHT”: Emphasizes dark scenes or colours in an image.
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3 When “CUSTOM” is selected in box 2, each of these colours
except “WHITE” can be adjusted respectively. As you adjust
“WHITE”, the values of the other three colours will be offset.

The “Reset & Transmit” button resets the values of the colour
currently selected. If you want to reset both the red and green
values, click the “Reset & Transmit” button in the “RED” mode,
and then click the “Reset & Transmit” button again in the
“GREEN” mode. If you want to reset to the original values, click
the “Reset & Transmit” button in the “WHITE” mode.

4 To send all the adjustment signals to the projector
5 To restore to the previous status after operating the gamma data.
6 To restore the status before the “UNDO” button was clicked.
7 Gamma coordinate display (INPUT/OUTPUT).

2 Select the “InputMode”.

3 Select “CUSTOM” or one of the other modes.
w When selecting the “MOVIE”, “FAMILY”, “SNOW”, or  “NIGHT”

mode, the “NOW TRANSMITTING...” message is displayed
during transmission.

4 When selecting “CUSTOM”, adjust the values of each
colour.
Drag and drop the curve of the graph to adjust it to the proper value.

5 Click “Transmit”.
w The “NOW TRANSMITTING...” message is displayed during

transmission.

Adjusting the Gamma curve

1 Repeat steps 1-4 of “Gamma Correction”.

2 Place the mouse pointer over the gamma curve.

The mouse pointer takes the shape of an open hand.
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3 Drag the gamma curve.

The mouse pointer takes the shape of a closed hand and the curve
changes.
The same operation is possible using the up and down arrow keys
on the keyboard.

Setting the gamma correction area
You can set the gamma correction area by using Drag and Drop. The
gamma curve and mouse pointer moves within the set range after setting
the gamma correction area.
The gamma correction area can also be set by using the right and left
arrow keys on the keyboard while pressing the shift key.

1 Drag the mouse pointer, then drop it.
The point at which the mouse pointer is released is set as the
correction area.

2 Drag and drop the gamma curve.
Gamma curve or mouse pointer moves within the set range.

� To restore to the previous status after operating the gamma data,
click the “UNDO” button.

� To restore to the status before the “UNDO” button was clicked, click
the “REDO” button.
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Saving the Gamma Correction Settings

1 Select “File”, then select “Save GAMMA Data”.
w This opens the “Save As” dialogue box.

2 Specify a “File name”.

3 Specify a “Save In” location.

4 Click “Save”.
The current gamma correction settings of the projector will be saved.

Loading the Gamma Correction Settings

1 Select “File”, then select “Load GAMMA Data”.
w This opens the “Open” dialogue box.

2 Specify a file location in “Look in”.

3 Specify a “File name”.

4 Specify a “Files of type”.

5 Click “Open”.
The gamma correction values will be loaded to the connected
projector.
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Setup for Transferring Images

Selecting the Projector

Specify the projector model to which you will transfer images.

1 Click the “File” menu to select “Select Projector...”.
w The “Select Projector” dialogue box will open.

Select “XGP10X” if you are using the XG-P10X, “PGC30X” if you
are using the PG-C30X.

2 Select the projector model for use and click “OK”.

For other models, select a projector from the screen.

Changing Connection Type
This menu is used to change the connection type. The port setting must
be made depending on which type you are going to use, infrared
communications or communications using RS-232C cable. The default
setting is “RS-232C”. Gamma Correction and RS-232C Control require
communications using RS-232C cable.

1 Click the “File” menu to select “RS-232C or Wireless
(IrCOM)...”.
w The “RS-232C or Wireless (IrCOM)” dialogue box will open.

“Transmission Speed” is changeable only for image transfer via
RS-232C.

2 Select “Com Status” according to your computer.

3 Select the connection type and click “OK”.
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Changing Compression Rate

When transferring a BMP image file by Presentation Transfer or
Capture & Transfer, you can change compression rates.

Compression rate
� Compression rate applies to BMP files only. This software does not

recompress JPEG files.
� The default setting for image quality is “middle”.
� If you are transmitting the custom Image (BMP) used as Startup Image

and Background Image, the image is automatically transmitted as
“High quality, slow transmission” for best results. The BMP file will be
transferred without any conversion to minimize the loss of image quality.

� If adjusted, the compression rate will be saved in each image folder
as a file. And the converted files remain in the folder so that the
conversion time can be shortened thereafter.

1 Click the “Option” menu, select “Compression Rate...”.

Better image quality
but slower transmission

Faster transmission
but poorer image
quality

2 Drag and drop the pointer to the rate position you desire.

3 Click “OK”.
w The compression rate in the selected folder will be changed.
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Saving a Custom Image as Startup Image and Background Image

The projector has an option to display a custom image (e.g. your company
logo) upon startup of the projector (Startup Image) or when there is no
signal (Background Image).
You can choose your custom image from the projector’s mode menu.
Refer to the projector’s operation manual for how to set Startup Image
and Background Image.
The following is the procedure for saving the custom image on the
projector.

� The startup image and background image are limited as follows:
1. 1024 × 768 or lower sized
2. If the pallet uses over 240 colours with 256 colour BMP files, the

image is automatically converted within the projector’s number of
colour limits.

3. 24-bit colour BMP files are converted into 256 colours.
� Selecting and leading the custom image file as Startup Image and

Background Image can be done by Presentation Transfer or
Capture & Transfer.

Select “Custom Image Transfer” in “Transfer Mode” of the
“Presentation Transfer” window or of the “Capture & Transfer”
window.
Refer to “Transferring Images” (page 35) for how to transfer the image.

The “Custom Image Transfer” mode saves one image file only and
overwrites the previously transferred image if you send another image
file.
To avoid erasing the custom image, you should change the transfer
mode to “Image Transfer” after sending the custom image.
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Transferring Images

Presentation Transfer

This mode makes it possible to transfer images saved as BMP or JPEG
files to the projector. A preview of the slides in the file folder selected is
displayed on the PC monitor.

Before Presentation
� RS-232C cable (cross type) is required for connecting the projector

with PC.
� Specify the projector model to which you will transfer images

(page 32).
� Save the slides as BMP or JPEG files. The image size must be

1024 × 768 or lower.
� Number of colours 16 bits or 24 bits for image transfer, 256 colours

only for startup transfer.

If you are using Microsoft PowerPoint or similar presentation software,
ensure the slide or page size is 1024 × 768 or lower. If the saved JPEG
slide size is too big, Sharp Advanced Presentation Software will prompt
you to reduce the slide size. You can lower the slide size in the “File”
menu, “Page Setup” or “Slide Setup” before converting to JPEG. (For
more details, refer to your presentation software’s operation manual.)

1) Open the desired presentation file.
2) Select “File”, then “Page Setup” or “Slide Setup”.
3) Change the page width and height to a smaller size.
4) Click “OK” for the new settings and save the slides in BMP or

JPEG format again.

� For Microsoft PowerPoint users:
1) Open the desired PowerPoint presentation.
2) Select “File”, then select “Save As”.

w This opens the “Save As” dialogue box.
3) Click “ ” in “Save as type”.
4) Select “JPEG”.
5) Specify a “File name” for the JPEG Images of your presentation.
6) Specify a “Save In” location.
7) Click “Save”.
8) A “PowerPoint” dialogue box appears. To convert the entire

presentation as JPEG images, click “Yes”. To convert only the
current slide, click “No”.
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1 Select the “Presentation Transfer” mode.
See section “Opening Modes” (page 12).
w The “Presentation Transfer” window will open.

2

5

4

6

1 3

1 Information of the selected image
2 Images in the selected folder (step 3)
3 Selecting the type of “Transfer Mode” (step 4)
4 Selecting the Presentation Method
5 Starts the “Self Run” transfer.
6 “Send Image” Transfer (page 37)

2 Click the “File” menu, and select “Open...”.
w The “Browse for Folder” window will open.

3 Select the folder in which the image files (Presentation
Slides) are saved. And click “OK”.
w The images in the selected folder are previewed in the

“Presentation Transfer” window.

If the size of image does not fill the box (800 × 500), the image will
be displayed with black space. However, the software will transfer
the image at the original resolution.
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4 Select “Image Transfer” in “Transfer Mode”.

For details of the “Custom Image Transfer”, see page 34.

5 On the projector side, the screen is automatically set to
the CUSTOM mode.
To restore to the previous screen, (INPUT 1, 2, 3) press input selector
key INPUT/Select button.

To send a single image (“Send Image”)

1 Select an image in the “Presentation Transfer” window
to transfer.
If you want to change the compression rate, see the section
“Changing Compression Rate” (page 33).

� The compression rate is applied to all the images in the selected folder.
� Changing the compression rate will change the image picture

quality and transfer speed.
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2 Click the “Current” button in the “Send Image” box.
w The “Transmitted File Information” dialogue box appears and

the transfer begins. If you want to stop the transfer, click “CANCEL”.

w To send the next image, click the “Next>” button in the “Send Image”
box.

w To send the previous image, click the “<Previous” button in the
“Send Image” box.

w The default order of images follows the file name.
You can change the order of the image files by dragging and dropping
them to the desired location.

To send all the images (“Self Run”)

1 Select the desired method in “Self Run”.
“Continuous” sends all images in the specified folder endlessly.
“Once” sends all images in the specified folder once.

2 Select the interval to send images in “Self Run”.
You can select it in the range from 30 seconds to 5 minutes fixed in
units of 15 seconds.

3 After step 4 on the previous page, press the “Start” button
in the “Self Run” box of the “Presentation Transfer”
window.

w The “Transmitted File Information” dialogue box will appear and
the transfer will begin. If you want to stop the transfer, click “Skip”.
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w After the transfer is completed, the “Slide wait” dialogue box will
appear until the image will be projected on the screen. If you want to
cancel the interval and soon show the next image, click “Next>>”.

w To cancel Self Run, click “Exit”.

Capture & Transfer

This mode allows you to transfer an image of what is currently displayed
on the PC monitor.

Before Presentation
� Connect a projector with PC by using RS-232C cable (page 6).
� Specify the projector model to which you will transfer images

(page 32).
� This function is not available for full screen slides (e.g. the “Slide

Show” mode of Microsoft PowerPoint).
For full screen slides to use Capture & Transfer, see the section
“Quick Transfer” (page 40).

1 Display the image you want to transfer.

2 Select the “Capture & Transfer” mode.
See section “Opening Modes” (page 12).
w The “Capture & Transfer” window will open.

Displays the type of 
“Transfer Mode” (step 3)
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3 Select “Image Transfer” in “Transfer Mode”.
If you want to change the compression rate, see the section
“Changing Compression Rate” (page 33).

� For the details of the “Custom Image Transfer”, see page 34.
� Changing the compression rate will change the image picture

quality and transfer speed.

On the projector side, the screen is automatically set to the CUSTOM
mode.

4 Click the “Capture & Transfer” button in the “Capture &
Transfer” window.
w The “Capture & Transfer” window disappears and capturing

begins.
w After capturing is completed, the “Capture & Transfer” window

reappears and transfer of the captured image begins.
w The “Transmitted File Information” dialogue box appears.

If you want to stop the transfer, click “CANCEL”.

To send another image
Change the displayed image on the PC monitor and then repeat step 4.

Quick Transfer

Applying the preset compression rate, this mode allows you to transfer
images by simple steps.

This mode transfers images under the following settings which cannot
be modified.

• Normal picture quality
• Compression rate: Middle

The custom image used as Startup Image and Background Image
cannot be transferred in this mode.

Before Presentation
� Confirm that the “Auto-Launch” setting is “ON” (page 14) and that

the software is active.
� Connect a projector with the PC by using RS-232C cable.
� Specify the projector model to which you will transfer images

(page 32).
� This function is available for full screen slides (e.g. the “Slide Show”

mode of Microsoft PowerPoint).



41

Transferring Im
ages

1 Display the image you want to transfer.

2 Keep the right mouse button depressed for 2 seconds.
The position of the pointer can be anywhere on the display.
w The “Quick Transfer” window opens.

On the projector side, the screen is automatically set to the CUSTOM
mode.

3 Click the “Capture & Transfer” button in the “Quick
Transfer” window.
w The capturing begins.
w The “Transmitted File Information” dialogue box appears and

the transfer of the captured image begins.
If you want to stop the transfer, click “CANCEL”.

w After the transfer is completed, the “Transmitted File
Information” dialogue box disappears.

4 Click “EXIT” in the “Quick Transfer” window.

To send another image
Change the displayed image on the PC monitor and repeat from step 2.
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Troubleshooting

Unable to transfer images or an error occurs with communication

H Check that the connection type is surely selected as you intend
(page 32).

H Check that the image size is 1024 × 768 or lower.

H Check that the port for the RS-232C serial cable is correctly specified
in the PC’s settings (page 32).

H Check that the cable is correctly and securely connected (page 6).

The functions in this software are not operating properly

H Reconnect the RS-232C serial cable and try again.
The cable may not be connected properly or an error may have
occurred during the transmission.

H Check that the port for serial (RS-232C) communications is correctly
specified in the PC’s settings (page 32).

H Projector may not be receiving command because of the projector’s
setting. Please check the projector’s “ON/OFF” status, “INPUT
SELECT” status (COMPUTER, VIDEO) or the input signal. Resend
the command after adjusting these items.

H Before Gamma Correction, use the projector’s Gamma button and
set the CUSTOM mode.

The transmitting speed is low

H Check the compression rate setting (page 33).

H Check the transmission speed, in the case of RS-232C cable
communications (page 32).

H Note that custom image as Startup Image and Background Image
is fixed in the “High quality, slow transmission” setting.

H Note that Quick Transfer is fixed in the “Normal quality, middle
speed” setting.

Unable to save the startup image

H Do not turn off the projector while transmission.
The image data may be lost.
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Quality of the image is low

H Check the compression rate setting (page 33).

H Note that Quick Transfer is fixed in the “Normal quality, middle
speed” setting.

Unable to speed up the transfer or improve the image quality

H If the image file is saved in JPEG format, its compression rate cannot
be changed.
Note that the compression rate only applies to BMP file format.

Unable to speed up “Gamma Correction” though the
transmitting speed was changed

H The transmitting speed setting applies to image transfer via cable
only. The speed for transfer of gamma values is fixed at 9,600 bps.
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Glossary

Version information

Specify if this software launches automatically upon startup

Image displayed when no signal is input. With the XG-P10X
and PG-C30X, same as startup image.

Image file format

Transfer an image of what is currently displayed on a monitor

Rate of compression of the images transmitted from a
PC to the projector

General term for background image and startup image

Transfer the custom image to the projector. (Unless the
custom image is transferred again (overwritten), the
screen is retained in the projector’s memory.)

Select an item and modify it using the mouse

Exit from this software

Main menu item

Projector’s specific values of specified colours

Adjust the projector’s gamma values from a PC

Help in using this software

Image file format

Set whether to enable or disable operating buttons on projector

Load all the saved “RS-232C Control” values to the
projector

Main menu item

Open file folder containing images to be transmitted to
the projector (for Presentation Transfer)

Main menu item

When a password is set, some functions can only be
changed by the person with the password.

Transfer a series of images (BMP or JPEG) to the projector

Shortcut to transferring an image of what is currently
displayed on a monitor

Communication method of the projector to a PC (Serial
Port)

Adjust the projector’s settings from a PC

About This Software

Auto-Launch ON/OFF

Background Image

BMP

Capture & Transfer

Compression Rate

Custom Image

Custom Image Transfer

Drag & Drop

Exit

File

Gamma

Gamma Correction

Help

JPEG

Keylock Level

Load Control Settings

Mode

Open

Option

Password

Presentation Transfer

Quick Transfer

RS-232C

RS-232C Control

Word Explanation Page
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32

24

38

34

34

32

Select method of communicating with the projector

Save all the current “RS-232C Control” settings of the
projector in a PC

Send slides in a specified folder one after another to
the projector

Image displayed when projector turned on. With the
XG-P10X and PG-C30X, same as background image.

Change the function from “Custom Image Transfer”
and/or “Image Transfer”

Transmission speed via the projector’s RS-232C port and
PC’s serial port

RS-232C
or Wireless (IrCOM)

Save Control Settings

Self Run

Startup Image

Transfer Mode

Transmission Speed

Word Explanation Page
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Services

Please contact nearest Sharp dealer if there are any problems.
For user purchased the projector in following countries, you can contact to the addresses
shown if you have problems.

USA Sharp Electronics Corporation
1-800-BE-SHARP (1-800-237-4277)
Icdsupport@sharplcd.com
http://www.sharp-usa.com/

Canada Sharp Electronics of Canada Ltd.
Sharp Customer Care Center
(905) 568-7140 (Local) or 877-742-7722(toll free)
http://www.sharp.ca

Mexico Sharp Electronics Corporation Mexico Branch
Servicio al cliente llame:
SHARP GENIAL
Respuestas inmediatas
(525) 716-9000

Germany Sharp Electronics (Europe) GMBH
01805-234675
http://www.sharp.de

U.K. Sharp Electronics (U.K.) Ltd.
0161-205-2333

Australia Sharp Corporation of Australia Pty.Ltd.
02-9830-4600
02-9672-1216 (Fax)
http://www.sharp.net.au

Hong Kong Sharp-Roxy (Hong Kong) Ltd.
2822-9303
2528-4879 (Fax)

Singapore Sharp-Roxy Sales (Singapore) Pte., Ltd.
65-4294342
http://www.sharp.com.sg
kwee@global.sharp.co.jp

U.A.E. Sharp Middle East Fze
971-4-81-5311
helpdesk@smef.global.sharp.co.jp

Thailand Sharp Thebnakorn Co., Ltd.
02-236-0170
02-236-9188 (Fax)
http://www.sharp-th.com

Korea Sharp Electronics Incorporated of Korea
(82) 2-3660-2002
(82) 2-3660-2029 (Fax)
http://www.sharp-korea.co.kr
webmaster@sharp-korea.co.kr

Information
You can see information about Sharp Advanced Presentation Software on the following
home page.
http://www.sharp-world.com/projector
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